
Power Point  

What is Power Point? 

PowerPoint is an application software. Which is used to make a 
presentation. Images, text videos and much more information are 
also used to create a presentation. The page on which the 
presentation is made is called slide. 

How to open Power Point in Computer? 

 Start Button 
 All Program 
 Microsoft Office 
 Click Power Point 

How to shortcut open power point in computer with keyboard? 

 Run Open (Window key + R) 
 Type powerpoint 
 Enter  
 Your power point has been opened 

 

CREATE PRESENTATION 

How to make presentation in Power Point? 

 Type Contents on the slide 
 To make your presentation colorful, go to the Design tab 
 Go to the Transitions tab to apply motion effects to the 

PowerPoint page or Slide 
 Go to the Animation tab to apply motion effects to the 

PowerPoint page or Slide 
 After doing all the above steps, your presentation will be made 
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DESIGN TAB  

Themes Group  

The page that works in PowerPoint is called a slide, so the slide 

The theme is used to create a beautiful color. 

 Click on the slide where you apply theme or colorful 
 Click Design Tab 
 Click on the theme to apply 
 It will apply to all your slides 

Note: - If the theme you clicked on is to apply on a single slide. 

 Design tab 
 Right click on the slide to apply 
 Click apply to select slide 
 Now the theme will be applied to only one slide. 

Note: - If you want to use a lot of themes 

 Click Theme group arrow button (For ex. ) 

Variants Group 

Variants group is used to three and four different colors of the theme 
you use on a slide. 

 Click on the slide 
 Variants Group 
 Choose theme color 
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Colors  

Colors are used to apply multiple colors on the same theme after 
applying a theme to any slide. 

Fonts  

After applying the theme on any slide, the font is used to change the 
font style of the typed text. 

Effects  

After applying the theme on any slide, the effects are used to change 
some different color effect in the same theme. 

Customize Group  

Slide Size  

Slide Size are used to make the size of the slide small and big or to set 
user according. 

 Design Tab 
 Customize Group 
 Slide Size 

Standard  

Standard is used to show width less and height higher in a slide. 

 Design tab 
 Slide size 
 Click Standard 
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Widescreen  

The windscreen is used to show width more and less height in the slide. 

 Design tab 
 Slide size 
 Click Widescreen 

Format Background  

You can apply the best multiple colors, textures, pictures and many 
other effects in the background of any slide. 

 Click on the slide 
 Design tab 
 Click Format background 
 The format background panel will open 
 Now you can apply multiple colors, textures, picture and any 

other effects. 
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Transition Tab  

Transitions to the slide Group  

After making a presentation in PowerPoint, we use the Transition 
Group to place a motion effect on the slide. 

 Click on the slide on which to apply motion effects. 
 Transitions Tab 
 Click on the motion effect you want to apply 
 Now to see the motion effect on the slide, press the F5 button 

from the keyboard. 

Note: - Click the arrow button to apply different types of motion effects 
to the slide.  

For Ex.   

Preview  

Preview is used to view the output of a motion effect using any slide. Or 
a preview is also used to create a presentation in PowerPoint and see 
its output. 

 Transitions Tab 
 Click preview 

Effect Options  

Effect options are used to show the same motion effect differently on 
the slide on which the motion effect is applied. 

 Click on the slide 
 Apply any one motion effect on the slide 
 Click effect options 
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 Now you can apply different types of motion effects. 

Timing Group  

Sound   

Sound is used to apply a sound effect or song to the slide on which you 
have worked. You can listen to the sound effect while showing the 
presentation. 

 Click on the slide 
 Transitions tab 
 Go to sound effect option 

 Click sound box arrow button (Ex.:-  This is Sound Box ) 
 Choose sound you want to apply 

Duration  

Duration is used to set the time of a sound effect by applying a sound 
to any slide. 

 Click on the slide that has a sound effect 
 Transitions Tab 
 Set the time by clicking the increase and decrease button in the 

Duration Box (For ex.  ) 

Apply To All  

If you apply a motion effect or sound effect to a single slide,  

Apply To All is used to apply the same motion effect or sound effect to 
all slides. 

 Transitions Tab 
 Click Apply To All 
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Advance Slide  

On Mouse Click  

On Mouse Click is used to move from one slide to another slide by 
pressing the left button of the mouse while showing the presentation. 

 Transitions Tab 
 Go to timing group 

 Click On Mouse Click check box (For Ex. ) 

After  

While showing the presentation, After is used to set the time to move 
from one slide to another slide and to play the slide automatically.  

 Transition Tab 
 Go to timing group 

 Uncheck on mouse click check box ( ) 

 Click check box and set time for a slide (For ex. ) 
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ANIMATION TAB  

Animation Group  

When creating a presentation in PowerPoint, use animation group 
for any content to be applied animation effect. Such as text, picture 
etc. 

 Click on the content like text or picture 
 Click Animation tab 
 Go to animation group 
 Click on any animation effect to apply 
 Preview is visible on clicking any animation. 

Note: - Click the arrow button to apply different types of Animation 
effects to the contents.  

For Ex.  
 

Preview  

After applying animation effects to the contents, the preview button 
is used to view its preview. 

 Click on the any contents like text or picture etc. 
 Animation tab 
 Apply animation effect 
 Click preview button 

 

Effect Option  

Effect options are used to show the same animation effect 
differently on the content on which the animation effect is applied. 

 Click on the any contents like text or picture etc. 
 Animation tab 
 Apply any animation effect on the content 
 Click Effect Option 
 Now you can apply different types of Animation effects. 

 

 

Arrow Button 
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Add Animation 

For any content that has more than one animation effect, add 
animation is used. 

 Click on the content which has an animation effect on it 
 Animation tab 
 Click Add Animation 
 Now you can apply more than one animation effect to the 

same content 
 

Animation Pane  

To remove animation effect by applying animation effect on any 
content or viewing the preview by applying animation effect to any 
content. 

 Animation tab 
 Click Animation Pane 
 You can see any animation effect on the content. 
 Right click on the animation effect that is to be removed. 
 Click remove 

Note:- Click the Play button to see the preview of the animation 
effect. 
 

Trigger  

Trigger are used to open any other content by clicking on one of the 
content. 

 Click on the content to be opened by clicking on other content 
 Apply an effect on this content 
 Animation tab 
 Click Trigger 
 Go to On Click of 
 Click on the content name on which you want to open the 

other content. 
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Animation Painter 

Copying the animation effect of one content to another content. 

 Click on the content that has an animation effect 
 Animation tab 
 Click Animation Painter 
 Click on the other content to copy the animation effect 

 

Start  

To start the animation by clicking the left button with the mouse. 

 Animation tab 
 Go to Start Option 
 Select On Click 
 Press F5 for Play Presentation 
 Now click the left button of the mouse to start the animation 

effect  

Duration 

Set the time of animation effect for how long you want it to run, 

 Click on the content that has an animation effect 
 Animation tab 
 Go to Duration Option 
 Set time for animation effect 

Delay  

Set delay time for the second animation effect after first animation 
effect run. 

 Click on the content on which to set the delay time 
 Animation Tab 
 Go to Delay Option 
 Set delay time for animation effect 
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Move Earlier  

Move Earlier is used for which animation to be shown first and which 
animation to show later. 

Note: - To show the subsequent animation effect first 

 Click on the content to be displayed first. 
 Animation Tab 
 Click Move Earlier 

 

Move Later   

Move Later is used for which animation to be shown later and which 
animation to show first. 

Note: - To show the previous animation effect later. 

 Click on the content to be displayed later 
 Animation Tab 
 Click Move Later 
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Slide Show Tab  

What is Slide Show tab? 

After creating a presentation in PowerPoint, we use the Slideshow tab 
to show the presentation in different ways to anyone. 

From Beginning  

You may have clicked on any slide, but from Beginning is used to show 
the presentation from the first slide. 

 Slide Show tab 
 Click From Beginning 
 Now the slide is played from the first slide 

From Current Slide  

The current slide is used to show the presentation on the slide that is 
clicked. 

 Slide Show Tab 
 Click From Current Slide 

Present Online  

Present online is used to display your presentation online on any 
browser. 

 Slide Show 
 Click Present Online 
 Office Presentation Service 
 Click Connect 
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Custom Slide Show  

Custom Slide Show are used to show the presentation of the selected 
slide. 

 Slide Show Tab 
 Custom Slide Show 
 Click Custom Show 
 Click New 
 Slide show name (Type any name) 
 Click on the slide check box to show the presentation 
 Click Add  
 Ok 
 Click Show 

Set Up Slide Show  

To automatically start the presentation again after finishing while 
showing the presentation. 

 Slide Show Tab 
 Click Set Up Slide Show 
 Click Check Box of the Loop continuously until ‘Esc’  
 Ok 
 Now the presentation will be automatically restarted while 

showing the presentation 

Hide Slide  

The Hide Slide is used to hide any slide while showing the presentation. 

 Click on the slide to hide 
 Slide Show Tab 
 Click Hide Slide 
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Rehearse Timings  

Setting different times on each slide through its typed content, how 
long to show that slide when showing the presentation. 

 Slide Show 
 Click Rehearse Timings 
 Now the time has started 
 Set the time on the first slide and click on the Next button 
 This is the way to set time on all slides 
 After setting the time on all the slides, there will be an option to 

save time. 
 Click Yes 

Note: - To see the time set on all slides 

 View Tab 
 Slide Sorter 

Record Slide Show  

To record something about your slide by recording your voice with a 
microphone. 

(1)  Start Recording from Beginning  

To record your voice from the first slide 

(2)  Start Recording from Current Slide  

To record your voice from the slide that is clicked 
 Slide Show Tab 
 Click From Beginning or Current Slide for record your voice  
 Now recording has started 
 Record your voice on the first slide and press the Next button for 

the second slide 
 Record your voice on all slides in this way 
 Now the voice will also play along with the slide while showing 

the presentation 
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Play Narrations 

To play the recorded voice from the microphone with a slide. 

 Slide Show 

 Click on the check box  of play narrations (For Ex ) 

Use Timings 

To use the time set on all slides from Rehearse Timings. 

 Slide Show 
 Click on the check box of the Use Timings (For Ex ) 

Show Media Controls 

Pause, stop and play the recorded voice on the slide while showing the 
presentation. 

 Slide Show 
 Click on the check box of the Show Media Controls (For Ex.   

Monitor  

To display the presentation on a different size monitor. 

 Slide Show Tab 
 Go to monitor option 
 Select Automatic 
 Now we can show the presentation on different size monitors. 
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REVIEW TAB  

Review tab Introduction 

Use the Review tab to correct spelling mistake, commenting in any 
word and comparing between two presentations when creating a 
presentation. 

Spelling  

To correct any word that has a spelling mistake in the slide 

 Click on the word in which the spelling is incorrect. 
 Review tab 
 Click Spelling 
 Click correct word 
 Click Change 

Note: - To change the spelling of all the words at once, click on  

Change All. 

Research  and Thesaurus  

In PowerPoint, research and thesaurus are used together and to find 
the English to English meaning of any word. 

 Click on that word to find meaning 
 Review Tab 
 Click Research and Thesaurus 
 See the meaning of that word 
 To change that word, click on the arrow button of the meaning 
 Click insert 

Translate  

To translate any word into a line in PowerPoint. 

 Click on the word to translate in a line 
 Review Tab 
 Translate 
 Click Translate Selected Text 
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 Now the clicked word is translated into a line. 

Language  

Language is used to work in another language in PowerPoint. 

 Review tab 
 Language 
 Click Language Preferences 
 Click on the language to work on (Under Choose Editing 

Language) 
 Ok 

Note: - To add the language in which you want to work in 
PowerPoint, go to the Start button and click on the Control Panel. 

New Comment  

Click on any word and write something about that word. 

 Click on the word to write something on 
 Review tab 
 New Comment 
 You can type whatever 

Delete  

To delete a comment posted on any word. 

Previous  

To see the comment of the previous word 

Next  

To see the comment of the later word. 

Show Comments  

Show comments are used to view and hide the comment symbol and 
comment panel.  

 Review tab 
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 Click Show Comments 
 Click Comments Pane or Show Markup for both hide or show 

Compare  

Compare is used to compare two presentations in PowerPoint and to 
add a slide to another presentation. 

 Review tab 
 Click Compare 
 Computer part will open 
 Select the second presentation saved on the computer 
 Click Merge 
 Now use the Revisions panel to compare slides or add slides 

from another presentation. 

Accept  

To add a slide from another presentation. 

 Click on another presentation slide 
 Review tab 
 Accept 

Reject  

To delete the slide of another presentation. 

 Click on another presentation slide 
 Review tab 
 Reject 

Previous  

To see the slide before the clicked slide 

 Click any slide 
 Review Tab 
 To see the previous slide click preview 
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Next  

To see the slide later the clicked slide 

 Click any slide 
 Review Tab 
 To see the later slide click next 

Reviewing Pane  

To hide and show the Revisions panel. Using the Revision panel 
compare two slides 

 Review tab 
 Click on Reviewing Pane to hide or show the Revisions Panel. 

End Review  

End Review used to exit the comparison page after comparing two 
presentations or adding slides to the second presentation. 

 Review tab 
 Click End Review 
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View Tab  

View Tab Introduction 

Show the slide in a normal way, applying the logo to all the slides, 

writing notes about the slide and viewing the slide in color with gray 

and black and white. 

Normal  

To see the slide in a normal way. 
 View Tab 
 Click Normal 

Outline View  
The outline view is used to edit any slide and direct jump from one 

slide to another slide. 
 View Tab 

 Outline View 

 Now you can edit any slide and jump from one slide to another. 

Slide Sorter  
Use slide sorter to view many slides at once. 

 View Tab 

 Click Slide Sorter 

 Now you can see all the slides 
Notes Page  
Clicking on the slide to write something about that slide is one line, 

two lines or more. 

 Click on the slide to write something about 

 View Tab 

 Click Notes Page 

 Now you can write anything about the slide 
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Reading View  

After making the presentation, the reading view is used to view the 

slide in full screen without playing the presentation. 
 View Tab 

 Click Reading View 


 
Now you can see the slide in full screen 

Slide Master  
To place a logo or a picture on all slides and to show the company 

name or any text in all the slides 
Note: - Use the slide master when starting the presentation. 

 Create a new page to create a presentation 

 View Tab 

 Click Slide Master 

 Go to the first slide using the slide bar and click on it 

 Insert tab 

 To add a logo, you have to go to the picture option or to type a 
text go to the text box 

 To exit the slide master option 

 Click Slide Master Tab 
 Close Master View 

Handout Master 
 Use the handout master to print more than one slide from the 

printer on a page. 
 Go to printing part or Press Ctrl + P 

 Go to Handout Option 

 Select the number of slides to print on a page 

 Click Print 
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Notes Master  

To print by typing text in the header and footer while printing the 

slide on the page from the printer. 

Header: - Top of the Page.    Footer: - Bottom of the Page. 

 View Tab 

 Click Notes Master 

 Go to header and footer for type text (For Ex. Company name 

or Address etc.) 

 Click Notes Master tab ( to exit the Notes Master ) 

 Click Close Master View 

 Print the slide to see the typed text. 

Ruler  

To show the scale on the slide so that it can measure the width and 

height of the shape and picture while working. 

 View Tab 

 Click Ruler Check Box  (For ex   )   

Gridlines  
Show gridlines in the background of the slide to perfect object 
placement. 

 View tab 

 Click Gridlines check box (For Ex  ) 

Guides  
Show adjustable drawing guides to which you can align object on the 
slide. 

 View Tab 

 Click Guides Check Box (For Ex 
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Notes  
To see the typed notes whatever you type about the slide using the 

notes page. 
 View tab 

 Click Notes Option 

Zoom  
To zoom in or out of the slide 

 View Tab 

 Click Zoom Option 

 Select Zoom Percentage or Type Percentage 

Fit to Window  

After using zoom in or zoom out, to fit the slide PowerPoint window 

screen or to display the slide as before 
 View Tab 

 Click Fit to Window 

Color  

To show the slide in colorful 

 View Tab 

 Click Color Option 

Grayscale  
To show the slide in gray color 

 View Tab 

 Click Grayscale Option 
Black and White  

To show the slide in Black and White 

 View Tab 

 Click Black and White Option 
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New Window  
To copy the created presentation to a new PowerPoint page. 

 View Tab 

 Click New Window 

Arrange All  
After opening more than one presentation, to see all the 
presentations at once. 

 Open more than one presentation 

 View Tab 

 Click Arrange All 

Cascade  
To see multiple presentation in an overlapping screen, overlapping 

means the second presentation behind the first presentation, the 

third presentation behind the second presentation. 
 Open more than one presentation 

 View Tab 
 Click Cascade 

Move Split  
Multiple slide screen or notes text box to make smaller or larger 

when creating a presentation. 
 View Tab 

 Click Split 

 Now you can use Split Option 

Switch Windows  

To jump from one presentation to another presentation 

 View Tab 

 Click Switch Windows 

 Click on the presentation to go to 
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Macros  

After learning all the options in PowerPoint to do advanced 

animation effects or more.  Do all the work in the macro using codes. 

 View Tab 

 Click Macros 

 Type Macro Name 

 Click Create 

 Type Macro Codes for Advance animation effects or more 
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